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1. Introduction to Kernel for Outlook Express

Welcome to the user manual of Kernel for Outlook Express, the most effective and powerful file repair
software that helps to recover emails from corrupted and damaged dbx files. This user manual will help
you with the step by step guidelines to use Kernel for Outlook Express software.

1.1 Using this Manual

This user manual provides you with the complete understanding of the software usage and its capabilities.
First time users are advised to read this user manual completely and carefully to gain the full
understanding of the software before starting with the actual repair procedure with Kernel for Outlook
Express.
Beginners should read the user manual completely while an experienced user can use the Table of
Contents to find out the information pertaining to the tasks that you need to perform with Kernel for
Outlook Express.
The table of contents helps you to navigate to different sections of the user manual. The table of contents
lists all the sections that are contained in this user manual in chronological order. The user manual
comprises the following sections:

e Introduction

o Getting Started

e Software Interface

e Repairing .DBX Files

e Saving Repaired .DBX Files

e Full Version

e Support

e Troubleshooting

e Legal Notices

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of
this user manual, please go through the list of abbreviations, mentioned below, before reading the manual.

1.1.1 List of Abbreviations

DBX: File extension for Outlook Express files

RAM: Random Access Memory
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MB: Mega-Byte

GB: Giga-Byte

MS: Microsoft

1.2 About Kernel for Outlook Express

Kernel for Outlook Express is a result oriented and powerful DBX file repair software to recover emails
from the corrupt, damaged, inaccessible .DBX files of MS Outlook Express. It successfully recovers emails
which have become inaccessible due to file corruption or have been deleted permanently from the
mailbox.

This software effectively repairs the dbx files of the user profile which is/are configured in Outlook Express
email client or any other dbx files which are provided by the user for repairing and recovery process.

It performs powerful and thorough scanning of the corrupt dbx file to cover up all the cases which could
lead to corruption of your dbx files. This software makes the emails accessible again which become
inaccessible due to corruption in dbx file header, virus infection, media corruption, accidental deletion etc.

You might be familiar with the following error messages while trying to open corrupt dbx files of Outlook
Express.

¢ MSIMN caused an invalid page fault in module Msoe.dll

e MSIMN caused an invalid page fault in module Msoe.dll at address

o OQutlook Express could not be started. It may not be installed correctly.
Make sure that your disk is not full or that you are not out of memory.

Contact Microsoft support for further assistance. (0x800c012¢)

o Outlook Express could not be started because Msoe.dll could not be initialized.
Outlook Express may not be installed correctly.

¢ MSIMN caused an exception C0000006h in module Directdb.dll
The message could not be sent. There is not enough Disk space.

e Unknown error has occurred. Protocol: SMTP Port: 0 Secure: No [SSL] Error: 0x800c0131

Kernel for Outlook Express quickly resolves the above listed errors by repairing corrupt .DBX files keeping
the email format intact. It successfully restores email formatting, email properties (to, from, bcc, date/time),
email data, attachments, embedded images, background images and all other email objects of the corrupt
.DBX file.

Kernel for Outlook Express provides complete and accurate recovery of email components, which ensures
that the attachments and email properties are associated with the correct email message.

It is embedded with two saving options: Save in .DBX and Save in .EML, which facilitates its user to save
the recovered emails in any of the available format.
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1.3 Salient Features

Salient features of Kernel for Outlook Express - email recovery software includes:

Interactive Graphical User Interface

Powerful email recovery engine

Powerful file repair engine

Support to Unicode language recovery

Recovers emails from Outlook Express 5.0, 5.5 and 6.0 .DBX files
Recovers emails which have been deleted from the ‘Deleted Items’ folder
Different saving options to filter the recovered email messages

Two saving formats ( .dbx or .eml) to save the recovered email messages
Facilitates to select and unselect recovered emails from the preview pane

Free demo to analyze capabilities of the tool before purchasing it

1.4 Who Should Use this Software?

administrators.

This software is useful for home users, professionals, college users or any other user who were not able to
perform receiving/sending of emails and also unable to access emails stored in dbx files due to dbx file
corruption. This corruption could have been caused due to virus attacks, improper system shutdown,

It is designed for people, who rely on Outlook Express, a simple and user friendly email client for their
email communication. The efficiency and capability of Kernel for Outlook Express software to repair
heavily corrupted and damaged files within minutes makes it the best choice for professionals and

media corruption where the dbx files are stored, installation of unsupported software, etc.

© KernelApps Private Limited
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2. Getting Started

Now that you have understood the features and usefulness of Kernel for Outlook Express, you are ready
to get hands on experience with the usage of the software. To start repairing dbx files, you will first need to
download and install the software.

It is strongly recommended that before installing Kernel for Outlook Express, you should go through the
installation pre-requisites of the software to ensure that your computer is meeting all the requirements
required to run the software.

2.1 Installation Pre-requisites

The various pre-requisites for installing and running Kernel for Outlook Express can be broadly classified
into two major categories — Hardware requirements and Software requirements.

2.1.1 Hardware Requirements:

The hardware requirements for installing the software are as follows:
e Pentium Class Processor
e Minimum 64MB RAM (128 MB recommended)
e 10MB for Software installation

e Disk Space - Enough space to store the repaired files

. You should have at-least 10 MB of free disk space if you want to repair and save a
10 MB .DBX file.

2.1.2 Software Requirements:

The software requirements for installing the software can further be grouped into two categories—
Operating system requirements and Outlook Express version requirements. The requirements are as
follows:

2.1.2.1 Operating System Requirements
Supported Operating Systems:

e Windows Vista

e Windows 2003

e Windows 2000

e Windows XP
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2.1.2.2 Outlook Express Version Requirements
Supported Outlook Express versions:

e Version5.0,5.5, 6.0
2.2 Downloading Kernel for Outlook Express for the First Time

After checking your computer with the prescribed system requirements for Kernel for Outlook Express, you
can download and install the software on your computer. You can buy the full version of the software from
any one of our authorized resellers— Element5, Asknet and 2CO.

If you want to try using Kernel for Outlook Express before buying it, you can download the evaluation
version from the following link:

https://www.nucleustechnologies.com/Download-Outlook-Express-Mails-Recovery-Software.php

X You can repair dbx files of the user profile configured on your system or dbx files
saved on your computer system by using evaluation version of Kernel for Outlook
Express; however, the evaluation version recovers all the email messages existing
in the dbx files but will save only 10 emails from each folder of the repaired file. To
save all the emails, full version needs to be purchased.

2.3 Install Kernel for Outlook Express

After downloading the installer file for Kernel for Outlook Express, you can install the software by running
the file.

To install Kernel for Outlook Express:

1. Double-click the Kernel for Outlook Express installer.
2. Follow the on-screen instructions.

The Setup Installation Complete screen will be displayed

3. Click Finish to launch the software.

2.4 Start Kernel for Outlook Express

To start Kernel for Outlook Express:
Click the Start = All Programs >Kernel for Outlook Express

Alternatively, you can launch Kernel for Outlook Express by double-clicking the shortcut icon available on
the Desktop and Quick Launch icon.

2.5 Uninstall Kernel for Outlook Express
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https://www.nucleustechnologies.com/Download-Outlook-Express-Mails-Recovery-Software.php

You may need to uninstall and re-install Kernel for Outlook Express. To uninstall Kernel for Outlook
Express:

1. Click the Start - All Programs >Kernel for Outlook Express - Uninstall Kernel for Outlook
Express

A warning message will be displayed.

2. Click ‘Yes’ to uninstall Kernel for Outlook Express.

X Before proceeding to uninstall Kernel for Outlook Express, you must ensure that the
software is not running in system background.

You can alternatively uninstall Kernel for Outlook Express from the Control Panel by performing the
following steps:

1. Click the Start Menu - Control Panel and then double click the Add or Remove Programs icon.
2. Select Kernel for Outlook Express and click Remove.
A warning message will be displayed.

3. Click ‘Yes’ to uninstall Kernel for Outlook Express.
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3. Software Interface

Now that Kernel for Outlook Express has been installed on your computer, you can start using the
software after getting acquainted with the software interface.

3.1 Menu-bar

The menu-bar of Kernel for Outlook Express comprises two main menus — File and Help.

3.1.1 File Menu

The File menu comprises three menu items.

File | Help

« | Open.. Ctrl =0

(2 | save Chrl=5
Exit

Figure 3.1: File Menu

Menu items in the File menu:

Open Select to browse and list corrupt .DBX files stored on your hard
disk

Save Select to get the Saving Options window to save the recovered
email items

Exit Select to close the software

3.1.2 Help Menu

The Help menu comprises three menu items.

Help
& | software Help Ctrl=H
Yisit Software Homepage

About Kernel for Qutlook Express

Figure 3.2: Help Menu

Menu items in the Help menu:
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Software Help Select to view Users Help Manual of Kernel for Outlook
Express
Visit Software Homepage Select to visit software homepage
About Kernel for Outlook Select to view version-related and support information of
Express Kernel for Outlook Express
3.2 Tool-bar

The tool-bar in Kernel for Outlook Express is displayed below the menu-bar. The tool-bar provides a
convenient and user-friendly method to perform certain actions that can also be performed by using the
menu-bar. Read the information in the table below to find out about the tool-bar buttons:

— Open Click to launch the "Open" window to select .DBX
\_} file from your disk drive for email recovery
Open
| Save Click to save the recovered email items from
selected .DBX file(s)
Save
@ v Select All Click to select all items of the selected file
o v
Select
@ v Unselect All Click to unselect all items of the selected file
(=1
UnSelect
Help Click to view User's Help Manual of Kernel for
9 Outlook Express
Help

Kernel %’
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4. Repairing .DBX Files

Now that you have complete familiarity of the user interface of Kernel for Outlook Express, you are ready
to repair .dbx files.

To repair .dbx files:

1. Launch Kernel for Outlook Express. By default, software opens up the "Open" window to browse for
.DBX file.

File Help

v @ W_hAm_h ) L:;h Kernel for Outlook Express

Open Save | Select UnSelect Help Recover Emails from Corrupt, Damaged .DBX Files
Folder List ChDocuments and Settings\Administrator\Local Settings\Application Data\ldentities\{B2ZAF00B5-7500-4C98-89DA-58204FETEAAG Microsoft\Outlook Ex..
L:J Ch\Document A | ¢ Oy |8 | From Subject DateTime

—j C:\Document

[¥]Z c\Document

[¥]Z cDocument
jl .
[#]05) {4B5CEa09-D029-4

—i C:\Document

o o= Lok e 2 iy Dacumert 90 # = @

— C\Document (Chimages [C)MucTempData

2] C:Document |y Integration Services Scripk Component 3501 Server Management Studio

__L;'J C:\Document [ Inkegration Services Script Task, [C25ymantec
== _'_[ED?SMBD'BB?D" My IMusic [ Updater

(A=) C\Dacument [y Pictures [=visual Studio 2008
li'] C:\Document [)Mew Folder

—| C:"Document
— C\Document <
— C\Document
—i C:\Document File: name: |
—i C:\Document
—j C:\Document
—j CDocument
— C\Document
[#]=) C\Document
[#]i= C\Document
¥ C\Document
—i C:\Document
—j C:\Document
— C\Document
— C\Document
—j C\Document
[#]i=) C\Document

=

o=

=

Saving proce:

Files of type: | DB File[" dbi)

< b

Figure 4.1: Main Window

A Kernel for Outlook Express displays the default user profile’s dbx files which is/are
configured and listed in Outlook Express.

2. Browse and list the .DBX file from your disk or select the default listed DBX files from left-hand pane to
view preview of the respective items.
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3. Select the folder from which you want to recover email items, software will scan that folder and will
display recovered items in tree like structure.

kernel for Qutlook Express - Evaluation Version 9.04.01 -

File Help
3.8 @ =
¢ tg | @v @wv | i ; Kernel for Outlook Express
Open Save | Select UnSelect |  Help s Recover Emails from Corrupt, Damaged .DBX Files
Folder List Total Items (5 ) Please select recovered emails to preview them (C\Documents and Settings® \Local Settings\Application Data\Identities\...
[V c\Decuments and Settings' & | 4 [ @  From Subject Date/Tirme

= C\Documents and Settings',
| C:"Documents and Settings',
| C:\Documents and Settings®
= C:\Documents and Settings'y
| C:"Documents and Settings',
| CDocuments and Settings®
= C:\Documents and Settings'
| C:\Documents and Settings®,
| C:%Documents and Settings,
=1 C:Documents and Settings",

| CDocuments and Settings®

| C:"Documents and Settings', i
| C:\Documents and Settings Available Manpower @ Just Rs.600}-

| C:%Documents and Settings, “sales@allindiajobbank.com” <sales@allindiajobbank.com=

| "Linkedin Email Confirmatio...  Pleaze confirm your email address Tue, 03 Feb 2003 14:56:52
= "TechRepublic Mews & Spe... Feb. 26th: See how Yol improves the... Thu, 12 Feb 2009 20:46:27
| “tdmin' <articles@articlesdf.. Spam: User dctivation Link From Articl.. Tue, 17 Feb 2009 13:20:22
= "'zalestaalindiajobbank.com... Available Manpower @ Just B B00/- taon, 20 Apr 2009 13:06:49
= "TechRepublic Daily Digest...  [TechRepublic] Have we entered the .. kon, 20 Apr 2009 14:48:21

e R

| C:%Documents and Settings®) o: O O_xdelhi@gmail.com” <aptexdelhi@gmail.coms
| CDocuments and Settings®)
| C:%Documents and Settings',
| C:\Documents and Settings®
| C:%Documents and Settings,
4 C:Documents and Settings*y 5 I ymgnm .
| C:\Documents and Settings --_000_2009042007093717637 gmails164bcom_
| C:\Documents and Settings® Content-Tvpe: text/'plain; charset="iso-8839-1"

i C:\Documents and Settings'y Content-Transfer-Encoding: quoted-printable

| Ct,Documents and Settings®,
| C:%Documents and Settings®,
1 C:"Documents and Settings®,
| C:Documents and Settings®,
| C:Documents and Settings®
[ C\Documents and Settings® As per vour mail for the requirement of the manpower requirement, im sendin=
| C:\Deocuments and Settings'y — g vou this mail pls, go through it, if it suits vour esteemed organization =

| C:\Documents and Settings'y than ele varrart 110 bacds Cla dnb Dactineg cac Be ANN anler and e salid—
[¥]i=) cDocuments and Settings', ¥ |
| >

Dear Sir'madam,

Figure 4.2: Recovered Emails

A Recovered email items in RED color signify recovery of permanently deleted emails.

4. Select the appropriate folder for saving and click Save button from toolbar.

Kernel €

© KernelApps Private Limited for Quiigok Exprass



oy | (2] & Kernel for Outlook Express

Halp Recover Emails from Corrupt, Damaged .DBX Files

i

Folder List Total Items (34 ) Please select recovered emails to preview them (Ch\Documents and Settings L ocal Settings\Application Data\ldentities\[FDATAICD-AS9A-4280-A5D..|
= [~ outiook Express -~
=[] § Administrator
= ¢l {3Fz30rre-25a4-
¥ C\Docunven
]2 £ Documen
¥ 2 £:\iocumen
¥l 23 C\Documen
¥ 23 C\Documen
¥l C\Docunen
[¥]_ C\Documen 2
¥ 24 C\Documen
¥ 5 £\Documen

& Saving Options

() Save a7 DEX [Select this option 1o zave emal in new DEX fie]

() Save a2 EML [Selact his oplion 1o save smals in EML fles)

T R T T

L]
=
=
=
=
=
=
= |
=l
=]

(%) Save ol salacted [Selact thiz option b save selscted recovensd emal)

PCWin Do () Save all (Select this option bo save eve recovered emals)

=
[¥] 3 C:\Documen PN i ) Save ol but deleed [Select this aption 1o save only the deleled recavesed emals]
] C\Docunen Tt Tgubi

[#] 3 C\Documen () Save all bul existing [Select this aption 1o save onky the edtting ecoveed smats
(¥} e-\Documen exchiding deleted recovernd emais)

Ej CADacumen Dear GroupWise to Exchange Migration,

P4 CovDocumen ™ Thanke you for your submission of GroupWse to Exchange Migraton to PCWin Download Center.

Figure 4.3: Saving Options Window

5. Saving Options window appears which asks for the saving option. Select the appropriate one and
click OK.
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5. Saving Repaired .DBX Files

On successful recovery of email items, Kernel for Outlook Express provides with the Saving Options
window intended to specify the saving options as per the user’s requirements.

Following saving options are available:

Save as DBX: This option saves the selected recovered items in new .DBX file at the defined save
location.

Save as EML: This option saves the selected recovered items in .EML files in a separate folder at
the defined save location.

Save all selected: This option saves all the selected emails.

Save all: This option saves every email item which is recovered from corrupt .DBX file / selected
folder(s) for saving.

Save all but deleted: This option saves only those emails which were permanently deleted and
are now recovered from corrupt .DBX file / selected folder(s) for saving.

Save all but existing: This option saves every email which is recovered from corrupt .DBX file /
selected folder(s) for saving except those emails which were permanently deleted and are now
recovered.

The first two saving options define the file format and the location where the recovered emails are allowed
to save while the last four options are used for the filtration of recovered emails to simplify the saving
process.

. Select any one option from the first two options and then select any one option from
the last four options.

X The evaluation version has only Save all option enabled, the rest three are disabled
(only in evaluation version).

5.1 Save as DBX

Perform the following steps to proceed with the saving process.

1. Select Save as DBX option from the Saving Options window in the software.

Kernel ‘I:J
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Eile  Heip
w w r
L g v ev ey | (7] ﬂ& Kernel for Outlook Express
i 5 lisy. Recover Emails from Corrupt, Damaged .DBX Files
Folder List Total Ttems (34 ) Please select recovered emails to preview them (CiDocuments and Settings IIINLocal Scttings\Application Data\identitics\[FDAZS2CD-ASIA-4280-A5D...

= [#liv Qutlook Express
=-[v] § administrator
= [W]L) {3F230FFB-2504-

|.
m[E
E]uﬁ

[FlL 21 o pocumen
[#]2 cpocumen
[#] 2 €\ Documen
[#]/5 C\Documen
¥ C\Documen
VL] C\Documen
Tﬁ:.'._ﬂ] Ceh Dascumven
V] 24 C\Documen
]:}L_a C:\Documen

i_; ﬂﬂnm -ATIA

[F115 C\Documen
¥ 3 C\Documen
L] C\Documen
[Pl C\Docunen
[#] 2 C\Documen
[#] 5 &\ Documen
115 C\Docunen
[¥] = C\Documen
[]. 3 C:\Documen
[#] C\Documen
[#] -] C\Docunven
[#]L21 C\Documen
[¥)L2] o pocunven
B0 & Documen

~

914 e\ Documen ™

>

=

: Saving Options rﬁ?‘

(&) Save o2 DEX (Select this option to zave emal in new DEX fie)

(r Save as EML [Select thes oplion 10 save emals in EML les)

R;\.‘.\‘.‘.\.‘-C\-
v e v

{#) Save all salected [Selact this opfion bo zave sedscted recovarsd emads)
PCWin Do (T Save ol [Select this option bo save every recavered emals)

P vy O Sawe ol but deleted [Select this aption 1o save onky the deleted tecovesed empls]

o "submi
(Cr Save all bul evisting [Select this oplion Lo save anly the exditing eeoveed emals
exchudng deleled recoveied emals]

Dear Group Wise to Exchange Migration,

Thank you for your submission of GroupWise to Exchange Migration to PCWin Download Center.

i

Figure 5.1 Saving Option

2. Select the other saving options as per your need: Save all selected, Save all, save all but deleted,
Save all but existing.

3. Click OK to continue with the process.

4. A new window ‘Outlook Express Folder Selection’ appears to select the Outlook Express folder which
saves the recovered emails in a sub folder created under the selected folder.

© KernelApps Private Limited
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Outlook Express Folder selection |E

Pleaze Select Faolder to zave emailz

A Pending
Deleted [tems
Dirafts

Tlalatt
COutbios

Sent [tems
gerl-DEx

] ] [ Cancel

Figure 5.2: Select Folder

5. Then click OK. Software starts the saving process. As soon as Kernel for Outlook Express finishes the
repairing and saving process, it displays the message “Saving Process is complete”.

Please wait while current process finishes

Poszible Spam ; [thaiviza.com] Breaking News: Thakzin sentenced to 2 vears in
jail

Saving ; C:A\Documents and Setting: L ocal S ettingshApplication

M ata dentitiezt dFTA 220 A998 -4 204 RN N-C 2R AANRA 720 Mbdicrnmn Tt

————————ceec |

Cancel
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Figure 5.3: Saving Process

6. Recovered emails can be now viewed in Outlook Express under selected main folder.

5.2 Save as EML

Follow these steps to save the recovered email items in EML file format.

1. Select Save as EML option from the Saving Options window.

x]

Saving Options

) Save az DEX [Select thiz option to save emailz in new DEX file]

(%) Save as EML [Select thiz option to save emailz in .EML files]

{(#)i5ave all zelected [Select thiz option to save selected recovered emailsh

) Save all [Select this option to save every recovered emails]
(3 Save all but deleted [Select thiz option ta zave only the deleted recavered emailz]

(3 Save all but exizting [Select thiz option ta zave only the existing recavered emails

excluding deleted recovered emailz]

[. aK ] [ Cancel ]

Figure 5.4 Saving Option- Save as EML

2. Select the other saving options as per your need: Save all selected, Save all, save all but deleted,
Save all but existing.

3. Click OK to continue with the process.

4. Software displays Browse for Folder window. Here you need to select a location, where the .EML
files will get saved and click OK to continue with saving process.
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Figure 5.5: “Browse for Folder” Window

5. Software starts the saving process. As soon as Kernel for Outlook Express finishes the repairing and
saving process, it displays the message “Saving process is complete”.

Please wait while current process finishes

Finding lozt emails ...

Saving : C:A\Daocuments and Settings Local SettingzhApplication
M atat] dentities s S FTE 2R 2T -4 990 -4 2 A0-A RN M-C2 TR A ANRA 720 Mo icrnsnftt

Cancel

Figure 5.6: Saving Process

6. Once emails are saved, they can be viewed from the saved location.

© KernelApps Private Limited for Quilaok Exprass



6. Full Version

Evaluation version is provided to get acquainted with the features and functions of Kernel for Outlook
Express. Although you can use Kernel for Outlook Express evaluation version for free and experience the
capabilities of the software, there are certain limitations in free evaluation version.

6.1 Requirement of Full Version

With free evaluation version of Kernel for Outlook Express, you can repair corrupt dbx files; however you
cannot save the entire recovered emails. Evaluation version allows saving of only first 10 emails from each
dbx files which have been recovered by the software.

You will need to buy the full version of the software to save the entire recovered emails.

6.2 Purchasing Full Version

You can buy the full version of Kernel for Outlook Express from any one of our authorized resellers —
Element5, Asknet and 2CO.

As soon as the purchase transaction with our resellers gets completed, our sales team will send you an
email comprising the URL to download the full version of Kernel for Outlook Express and activation details
of the software.
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/. Support

We have an extensive and efficient support system in place to assist our customers with all issues related
to using Kernel for Outlook Express. The software comes with an embedded help manual that can
be accessed by clicking Help >Software Help in the menu-bar. You can also press the F1 key on
the keyboard of your computer to access the embedded help of Kernel for Outlook Express.

You can access the online help for Kernel for Outlook Express at
https://www.nucleustechnologies.com/Online-Helps.html

View Animated Working Demo of the software at
https://www.nucleustechnologies.com/Animated Demo Mails.html

We also have live support wherein you can chat with our software experts at
https://www.nucleustechnologies.com/supportcenter/

To talk on phone with our software experts call:

Help line:

+91-9818725861
1-866-348-7872 (Toll Free for USA/CANADA)
You can also email us about your queries at;

sales@nucleustechnologies.com for Sales

support@nucleustechnologies.com for Support

contact@nucleustechnologies.com for General Queries
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8. Troubleshooting

This section deals with your generic and specific queries pertaining to using Kernel for Outlook Express.

8.1 Common Issues

Why does Kernel for Outlook Express have limitations in evaluation copy?

The free evaluation version of Kernel for Outlook Express enables its users to get acquainted with the
features and functions of the software before purchasing the full version of the software. Free demo
version saves only 10 emails from each folder. To save the entire recovered emails, full version needs to
be purchased.

8.2 Frequently Asked Questions

How to Buy Kernel for Outlook Express?

You can buy Kernel for Outlook Express online at https://www.nucleustechnologies.com/Buy-
Outlook-Express-Mails-Recovery-Software.php

I have lost my full version for Kernel for Outlook Express. Can you help me?

Please email us at sales@nucleustechnologies.com. Please include your name, address, email address,
and order confirmation number (if you have it). We will be happy to help you.

How to identify the deleted emails which are recovered by the software?

Recovered deleted emails are displayed in RED color for identification.

What are the supported versions of Outlook Express?

Kernel for Outlook Express supports repairing of dbx files created with Outlook Express 5.0 and above.
How much time would be required to repair the corrupt dbx files?

Repair and recovery time depends on the intensity of the corruption caused to your dbx files.

Evaluation version does not save all the recovered emails. With free evaluation version, how can |
know that the software is powerful enough to provide complete and exact recovery of email and its
associated properties?

Kernel for Outlook Express is equipped with a view preview before saving feature. With this feature, you

can analyze the correctness and completeness of your emails and its associated properties before saving.
In this way, you can check the efficiency of the software before buying its full version.
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9. Legal Notices

This section comprises the legal specification about Kernel for Outlook Express and the
company KernelApps Private Limited.

9.1 Copyright

KernelApps Private Limited, Kernel accompanied user manual and documentation are copyright
of KernelApps Private Limited, with all rights reserved. Under the copyright laws, this user
manual cannot be reproduced in any form without the prior written permission of KernelApps
Private Limited. No Patent Liability is assumed, however, with respect to the use of the information
contained herein.

© KernelApps Private Limited. All rights reserved.
9.2 Trademark

Kernel ® is a copyright work of KernelApps Private Limited.

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000
Advanced Server®, Windows 2003 Server®, Windows XP®, Windows Vista®, MS-DOS and Outlook
Express are registered trademarks of Microsoft Corporation.

All other brand and product names are trademarks or registered trademarks of their respective companies.

9.3 Disclaimer

The Information contained in this manual, including but not limited to any product specifications, is subject
to change without notice. KernelApps Private Limited provides no warranty with regard to this manual or
any other information contained herein and here by expressly disclaims any implied warranties of
merchantability or fitness for any particular purpose with regard to any of the foregoing
KernelApps Private Limited assumes no liability for any damages incurred directly or indirectly
from any technical or typographical errors or omissions contained herein or for
discrepancies between the product and the manual. In no event shall KernelApps Private
Limited, be liable for any incidental, consequential special, or exemplary damages, whether based
on tort, contract or otherwise, arising out of or in connection with this manual or any
other information contained herein or the use there of.

9.4 License Agreement

Kernel for Outlook Express Copyright © by KernelApps Private Limited.
Your Agreement to this License

You should carefully read the following terms and conditions before using, installing or distributing
this software, unless you have a different license agreement signed by KernelApps Private Limited.
The terms and conditions of this License describe the permitted use and users of each Licensed
Copy of Kernel for Outlook Express. For purposes of this License, if you have a valid license,
you have the right to use a single Licensed Copy of Kernel.
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Scope of License

Each Licensed Copy of Kernel for Outlook Express may either be used by a single person or used non-
simultaneously by multiple people who use the software personally installed on a single workstation.
All rights of any kind in Kernel, which are not expressly granted in this License, are entirely and
exclusively reserved to and by KernelApps Private Limited. You may not rent, lease, modify, translate,
reverse engineer, decompile, disassemble, or create derivative works based on, Kernel, nor permit
anyone else to do so. You may not make access to Kernel available to others in connection with a
service bureau, application service provider, or similar business, nor permit anyone else to do so.

Warranty Disclaimers and Liability Limitations

Kernel for Outlook Express, and any and all accompanying software, files, data and materials,
are distributed and provided AS IS and with no warranties of any kind, whether expressed or
implied. In particular, there is no warranty for the quality of data recovered. You acknowledge
that good data processing procedure dictates that any program, including Kernel, must be thoroughly
tested with non-critical data before there is any reliance on it, and you hereby assume the entire risk of all
use of the copies of Kernel covered by this License. This disclaimer of warranty constitutes an essential
part of this License. In addition, in no event does KernelApps Private Limited
authorize you or anyone else to use Kernel for Outlook Express in applications or systems where
Kernel for Outlook Express failure to perform can reasonably be expected to result in a significant physical
injury, or in loss of life. Any such use is entirely at your own risk, and you agree to hold
KernelApps Private Limited harmless from any and all claims or losses relating to such
unauthorized use.

General

This License is the complete statement of the agreement between the parties on the subject matter,
and merges and supersedes all other or prior understandings, purchase orders, agreements
and arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction
and venue for all matters relating to this License shall be in courts and for a located in the State of Delhi,
and you consent to such jurisdiction and venue. There are no third party beneficiaries of
any promises, obligations or representations made by KernelApps Private Limited herein.

Any waiver by KernelApps Private Limited of any violation of this License by you shall not constitute,
nor contribute to, a waiver by KernelApps Private Limited of any other or future violation of the
same provision, or any other provision, of this License.
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